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Introduction

Ce chapitre couvre les méthodes pour éditer des documents partagés : partager (collaboration),
enregistrer les modifications, ajouter des commentaires, réviser les modifications, fusionner et
comparer des documents, enregistrer et utiliser des versions des documents. Les techniques
d'édition de base sont abordées dans le Chapitre 2 (Entrer, Modifier et Formater des Données).

Partager des documents (collaboration)

Dans LibreOffice Writer, Impress et Draw, un seul utilisateur a la fois peut ouvrir un document pour
édition. Dans Calc, plusieurs utilisateurs peuvent ouvrir simultanément le méme classeur dans le
mode écriture.

Il est fortement recommandé que chaque collaborateur saisisse son nom dans Outils > Options >
LibreOffice > Données d'identité. Dans le cas contraire, ses contributions (modifications et
commentaires) seront créditées a un auteur inconnu.

Certaines commandes des menus sont indisponibles (grisées) quand I'enregistrement des
modifications ou le partage du document est actif.

Paramétrer un classeur pour le partage

A tout moment, vous pouvez paramétrer un classeur pour le partager avec d'autres utilisateurs.
Une fois le classeur ouvert, choisissez Outils > Partager le document pour activer les
fonctionnalités de collaboration pour ce document.

Partager le document @

| Partager cette feuille avec d'autres utilisateurs:

Remarque : les modifications des attributs de formatage comme les
polices, les couleurs et les formats de nombre ne seront pas
enregistrées et certaines fonctions comme I'édition des diagrammes
et les objets de dessin ne sont pas disponibles en mode partagé.
Dézactiver le mode partage pour avoir un acceés exclusif nécessaire
pour ces modifications et fonctions.

Litilisateurs accédant actuellerment a cette feuille de calcul

Mom Accédé
Chris (acces exclusif) 15/06/2012 11:41

Aide oK ] | Annuler

Figure 1 : Choisir de partager un classeur

Pour activer le partage, cochez la case en haut de la boite de dialogue, puis cliquez sur OK. Un
message apparait vous indiquant que vous devez enregistrer le document afin d'activer le mode
partagé. Cliquez sur Oui pour continuer. La mention (partagé) est alors affichée dans la barre de
titre, a la suite du nom du fichier.
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La commande Outils > Partager le document peut étre utilisée pour basculer un document du
mode non partagé au mode partagé. Cependant, si vous voulez utiliser un document partagé en
mode non partagé, vous devez d'abord enregistrer le document partagé avec un autre nom ou un
autre chemin. Ceci crée une copie du classeur qui n'est pas partagée.

Ouvrir un classeur partagé

Lorsque vous ouvrez un classeur qui est en mode partagé€, un message apparait vous indiquant
que le document est en mode partagé et que certaines fonctionnalités ne sont pas disponibles
dans ce mode. Cliquez sur OK, et le document est ouvert en mode partagé.

Les fonctions suivantes ne sont pas disponibles dans un classeur partagé :

Edition > Modifications, sauf Fusionner le document
Edition > Comparer le document

Edition > Feuille > Déplacer/copier et Supprimer
Insertion > Cellules > Déplacer les cellules vers le bas et Déplacer les cellules vers la droite
Insertion > Feuille a partir d'un fichier

Insertion > Noms

Insertion > Commentaire

Insertion > Image

Insertion > Vidéo et son

Insertion > Objet

Insertion > Diagramme

Insertion > Cadre flottant

Format > Feuille > Renommer et Couleur d'onglet
Format > Fusionner les cellules

Format > Zones d'impression

Outils > Protéger le document

Données > Définir la plage

Données > Trier

Données > Sous-totaux

Données > Validité

Données > Opérations multiples

Données > Consolider

Données > Plan et groupe

Données > Table de pilote

Enregistrer un classeur partagé
Quand vous enregistrez un classeur partage, une des situations suivantes peut se produire :

* Sile document n'a pas été modifié et enregistré par un autre utilisateur depuis que vous
l'avez ouvert, le document sera enregistré.

* Sile document a été modifié et enregistré par un autre utilisateur depuis que vous l'avez
ouvert, 'un des événements suivants va se produire :

-  Siles changements ne sont pas en conflit, le document est enregistré. Un message
apparait, vous indiquant que votre classeur a été mis a jour et enregistré par d'autres
utilisateurs, et toutes les cellules modifiées par l'autre utilisateur apparaissent avec
une bordure rouge.

- Si les changements sont en conflit, la botte de dialogue Résoudre les conflits s'ouvre.
Vous devez décider pour chaque conflit quelle version conserver, la vbtre ou celle de
l'autre personne. Lorsque tous les conflits sont résolus, le document est enregistré.
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Pendant que vous résolvez les conflits, aucun autre utilisateur ne peut enregistrer le
document partagé.

* Siun autre utilisateur essaie d'enregistrer le document partagé et de résoudre les conflits,
un message apparait vous indiquant que le fichier classeur partagé est verrouillé a cause
d'une fusion en cours. Vous pouvez alors renoncer a la commande Enregistrer pour le
moment, et ré-essayer plus tard.

Une fois que vous avez enregistré avec succes un document partagé, le document affiche la toute
derniére version de tous les changements enregistrés par tous les utilisateurs.

Enregistrer les modifications

Vous pouvez utiliser plusieurs méthodes pour enregistrer les modifications que vous ou d'autres
utilisateurs font dans un document.

* Vous pouvez utiliser les marques de modifications pour montrer les ajouts, les
suppressions et les changements de formats. Plus tard, vous (ou un autre utilisateur)
pourrez réviser le document et accepter ou rejeter chaque modification.

* Sivous n'utilisez pas le partage de fichier, vous pouvez effectuer les modifications dans
une copie du document (enregistré dans un dossier différent, avec un nom différent, ou les
deux), puis utiliser Calc pour comparer les fichiers et mettre en évidence les changements.
Voir "Comparer des documents" page 15.

* \ous pouvez enregistrer des versions qui seront conservées dans le fichier original. Voir
"Enregistrer des versions" page 15.

Les relecteurs peuvent laisser des commentaires dans le document, attachés a des modifications
particuliéres ou autonomes.

Note Ces outils sont identiques a ceux utilisés dans Writer pour le suivi des modifications.

Préparer un document pour la révision

Quand vous envoyez un document & un autre utilisateur pour révision ou édition, vous pouvez tout
d'abord vouloir le protéger afin que I'éditeur ou le relecteur n'ait pas a se souvenir de bien activer
les margques de modifications. Une fois que vous avez protégé le document, tout utilisateur doit
entrer un mot de passe correct pour désactiver la protection et accepter ou rejeter les
modifications.

1) Ouvrez le document et sélectionnez Edition > Modifications > Enregistrer. Une coche
apparait devant cette option pour indiquer que l'enregistrement est actif.

2) (Optionnel) Cliquez sur Edition > Modifications > Protéger I'historique. Dans la boite de
dialogue Protéger I'historique, saisissez un mot de passe, confirmez-le et cliquez sur OK.

Identifier les copies des classeurs

Si vous n'utilisez pas la fonctionnalité de partage du document, il peut étre important de garder une
trace des différentes copies de ce document. Ceci peut étre effectué dans le nom ou dans le titre
du fichier. Si vous n'avez pas donné de titre au fichier dans les propriétés du classeur, le nom de
fichier du classeur est affiché dans la barre de titre. Pour déterminer le titre du classeur,
sélectionnez Fichier > Propriétés onglet Description.
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Enregistrer les modifications

La suite de ce chapitre va étre illustrée par I'exemple de I'élaboration d'un budget pour une équipe
de football.

Mettez-vous dans la situation d'un président d'un club de football. L'entraineur d'une équipe de
jeunes vous a soumis un budget pour la saison, et vous avez besoin de le modifier et de lui
retourner la nouvelle version.

Vous vous inquiétez du fait que, si vous faites simplement des modifications, I'entraineur ne verra
donc pas les changements que vous avez effectués. Vous décidez alors d'utiliser et d'activer la
fonctionnalité d'enregistrement des modifications, pour que I'entraineur puisse voir facilement les
changements que vous avez effectués.

La Figure 2 montre le classeur du budget que I'entraineur vous a soumis.

g —— B | c | D | E
1 Budget Equipe Cadets Football
2 [Description Quantité Prix Total Commentaire
3 [Maillots, shorts et chaussettes 15 40,00 € 600,00 € Besoin d'un nouveau look pour I'équipe
4 |Ballons entrainement 20 20,00 € 400,00 €1 par joueur + 5 en résenve
5 |Ballons match 3 40,00 € 120,00 €Pour la saison
6 |Colts arbitrage 18 50,00 € 900,00 €1 arbitre par match
7 |[Collations 18 40,00 € 720,00 €1 collation d'aprés-match par match
8 |Gants gardien 1 15,00 € 15,00 € Pour le gardien
9 |Protége-tibias de rechange 5 15,00 € 75,00 € Dans le cas ol un joueur oublie ses protections
10 |Chasubles entrainement 20 4.00€ 80,00 €1 par joueur + 5 en résenve
11 |Total 291000 €
12
13

Figure 2 : Classeur budget de I'équipe de football

En examinant les chiffres, vous voyez que vous pourriez économiser sur certains postes :

* Les collations d'aprés-match peuvent étre apportées par les parents.

* Les nouveaux maillots peuvent attendre : en acheter seulement 5 pour remplacer ceux qui
sont uses.

* Acheter des ballons d’entrainement moins chers.

* Acheter seulement 2 protége-tibias de rechange.
Pour effectuer ces modifications, utilisez I'enregistrement des modifications de Calc. Pour
commencer cet enregistrement :

1) Ouvrez le classeur contenant le budget.

2) Sélectionnez Edition > Modifications > Enregistrer dans la barre de menus.

3) Commencez a modifier le document.
Une bordure colorée, avec un point dans son coin supérieur gauche (comportement par défaut),
apparait autour de la cellule ou une modification a été effectuée (Figure 3). Les autres utilisateurs

peuvent alors facilement savoir quelles cellules ont été modifiées. Une ligne ou une colonne
supprimée est marquée par une barre colorée épaisse.
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Description

Maillots, shorts et chaussettes
Ballons entrainement

Ballons match

Colts arbitrage

Collations

Gants gardien

Protége-tibias de rechange
Chasubles entrainement

Total

ﬁummqmmhwm =

[y
(%)

13

Quantité

5

D | E

Prix
40,00 €

20
3
18

1

15,00 €

40,00 €
50,00 €
40,00 €
15,00 €

2

15,00 €

20

4,00 €

Budget Equipe Cadets Football

Total

Commentaire
200,00 € Besoin d'un nouveau look pour [équipe
300,00 €1 par jousur + 5 en réserve
120,00 € Pour la saison
900,00 €1 arbitre par match
0,00 €1 collation d'aprés-match par match

15,00 € Pour le gardien

30,00 € Dans le cas ol un joueur oublie ses protections

80,00 €1 par joueur + 5 en résenve
1 645.00 €

Figure 3 : Document édité avec cellules modifiées entourées en rouge

Note

Certaines modifications, comme le formatage d'une cellule par exemple, ne sont pas
enregistrées et signalées.

Pour modifier la couleur qui signale les modifications, sélectionnez Outils >

Astuce

Options > LibreOffice Calc > Modifications. Par défaut, une couleur différente
sera attribuée a chaque relecteur (s'il a pris soin de renseigner son nom comme

indiqué dans "Partager des documents (collaboration)" page 4).

Une fois que vous avez terminé vos modifications dans le document, vous pouvez I'envoyer a

votre entraineur.

Vous pouvez vouloir expliquer votre raisonnement qui a guidé les modifications effectuées. Vous
pouvez exprimer votre point de vue de deux maniéres : en ajoutant des commentaires aux
changements que vous avez effectués, ou en ajoutant des commentaires globaux au classeur.

Ajouter des commentaires aux modifications

Calc ajoute automatiquement a toute modification enregistrée un commentaire qui précise ce qui a
été modifié (par exemple, Cellule B3 modifiée de '15' en '5"). Les relecteurs et les auteurs peuvent
ajouter leurs propres commentaires pour expliquer les raisons de leurs modifications.

Pour ajouter un commentaire a une modification :

1)
2)
3)

Faites la modification dans le classeur.
Sélectionnez la cellule ou la modification a été effectuée.
Choisissez Edition > Modifications > Commentaires. La boite de dialogue de la Figure 4

s'ouvre. Le commentaire ajouté automatiquement par Calc est affiché dans la barre de titre
de la boite de dialogue et ne peut pas étre modifié.

4)

Saisissez votre propre commentaire et cliquez sur OK.

Partager et Réviser des Documents



Vous pouvez parcourir toutes vos modifications en une seule fois en utilisant les
fleches gauche et droite situées sur le coté droit de la boite de dialogue du
commentaire, et ajouter ainsi vos commentaires a chaque modification. La barre

Astuce de titre de la boite de dialogue vous indique la cellule et la modification que vous
étes en train de commenter. Vous n'avez pas besoin de cliquer sur OK apres
chague commentaire ajouté : vous pouvez tous les enregistrer en une fois lorsque
vous avez terminé.

On ne remplace que les équipements usés|

Cellule B3 modifiée de '15' en 'S’ (]
Contenu
. [ oK |
Auteur Chris, 17/06/2012 15:47
Texte | Annuler |

13
I
=8
m

¢

P 1 3

Inzérer

Figure 4 : Boite de dialogue du commentaire

Une fois que vous avez ajouté un commentaire a une cellule modifiée, vous pouvez l'afficher (sous
forme d'info-bulle) en placant le pointeur de la souris au-dessus de la cellule, comme indiqué
Figure 5 :

A e C | D | E

BUdget E¢Chris  17/06/2012 15:47-29:

1

By > —0On ne remplace gue les équipements uses.
2 _|Description Quantité ( Cellule B3 modifiée de'15 en'5)

3 |Maillots, shorts et chaussettes

S Ballons entrainement |
5 |Ballons match 3

Figure 5 : Commentaire ajouté a la cellule B3

look pour I
300,00 €1 par joueur + & en réserve
120,00 € Pour la saison

40,00 €

Le commentaire s'affiche également dans la boite de dialogue ol vous acceptez ou refusez les
modifications, comme illustré sur la premiére ligne de la Figure 10 page 13.

Modifier les commentaires des modifications

1) Sélectionnez la cellule dont vous voulez modifier le commentaire.
2) Choisissez Edition > Modifications > Commentaires.
3) Modifiez le commentaire et cliquez sur OK.

Ajouter des commentaires aux modifications 9



Ajouter d'autres commentaires

Calc dispose également d'un autre type de commentaires (appelés "notes" dans les anciennes
versions de LibreOffice), que les auteurs et les relecteurs utilisent souvent pour échanger des
idées, formuler des suggestions et réfléchir collectivement dans un document.

Pour ajouter un commentaire :

1) Sélectionnez la cellule a laquelle le commentaire va s'appliquer.

2) Sélectionnez Insertion > Commentaire ou faites un clic droit et choisissez Insérer un
commentaire (cette derniére méthode ne fonctionnera pas si la correction orthographique
automatique est active et si la cellule contient un mot incorrect). Une zone de saisie
apparait, comme Figure 6.

3) Saisissez le texte de votre commentaire dans cette zone.
4) Cliquez en dehors de la zone pour la fermer.

Commentaire

Besoin d'un nouveau look pour I'équipe

1 par joueur + 5 en réserve

Four la saison

1 arbitre par match

1 collation d'aprés-match par match

Four le gardien

Dans le cas ol un joueur oublie ses protections
B8 joueur + 5 en réserve '

Figure 6 : Insérer un commentaire

La cellule a laquelle vous avez ajouté un commentaire comporte désormais un point coloré dans le
coin supérieur droit, comme illustré Figure 7. Elle n‘a pas de bordure colorée, a moins que la
cellule ait été également modifiée.

Dans le cas ol un joueur oublie ses protections
1 par joueur + 5 en résernve

Figure 7 : Point coloré dans une cellule
comportant un commentaire

Si le point coloré n'apparait pas pour signaler une cellule dans laquelle se trouve un
Note commentaire, vérifiez, dans Outils > Options > LibreOffice Calc > Affichage, si
I'option Indicateur de commentaire est bien cochée.

Vous pouvez modifier la couleur d'arriere-plan par défaut des commentaires dans
Outils > Options > LibreOffice > Apparence section Classeur. Vous pouvez
aussi modifier individuellement la couleur d'arriére-plan de chague commentaire :
voir "Formater les commentaires” page 11.

Astuce

Pour afficher le commentaire que vous venez d'ajouter, placez le pointeur de la souris au-dessus
de la cellule correspondante ; le commentaire apparait, comme ci-dessous.
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1 arbitre par match

1 collation d'aprés-match par match

Pour le gardien

‘Dans le cas ol un joueur oublie ses protections
‘1 par jousur + 5 en résenve

Figure 8 : Afficher un commentaire

FPourguoi 5 en
réserve 7

Modifier des commentaires

Vous pouvez modifier et formater le texte d'un commentaire, comme vous le feriez pour tout autre

texte.

1) Faites un clic droit dans la cellule contenant l'indicateur de commentaire et choisissez
Afficher le commentaire dans le menu contextuel.

2) Sélectionnez le commentaire, puis double-cliquez a l'intérieur. Le curseur change d'aspect
pour devenir celui habituel qui marque I'entrée de texte en clignotant, et la barre d'outils
Formatage qui était indisponible devient active et affiche les attributs du texte.

3) Une fois la modification effectuée, cliquez a I'extérieur du commentaire pour le
désélectionner. Pour masquer a nouveau le commentaire, faites un clic droit dans la cellule
et décochez Afficher le commentaire dans le menu contextuel.

Pour modifier un commentaire masqué, faites un clic droit sur la cellule puis
Ast choisissez Insérer un commentaire. Vous accédez alors directement en
Stuce modification et il suffit ensuite de cliquer en dehors du commentaire pour qu'il soit

masqué de nouveau.

Formater les commentaires

Vous pouvez changer la couleur d'arriére-plan, le style de bordure, la transparence et d'autres
attributs d'un commentaire.

1)

2)

3)

Faites un clic droit dans la cellule contenant l'indicateur de commentaire et choisissez
Afficher le commentaire dans le menu contextuel.

Cliquez dans le commentaire lui-méme. La barre d'outils Formatage change pour afficher
la plupart des options de formatage des commentaires. Ce sont les mémes que les options
pour formater les éléments graphiques ; voir le Chapitre 5 (Utiliser des Eléments
Graphiques dans Calc) pour plus d'informations.

Vous pouvez également faire un clic droit sur le commentaire pour afficher un menu
d'options, certaines menant a des boites de dialogue vous permettant de paramétrer
finement le formatage ; ces boites de dialogue sont également décrites dans le Chapitre 5.
Une fois la modification effectuée, cliquez a I'extérieur du commentaire pour le dé-
sélectionner. Pour masquer a nouveau le commentaire, faites un clic droit dans la cellule et
décochez Afficher le commentaire dans le menu contextuel.

Rechercher les commentaires en utilisant le Navigateur

Les petits indicateurs de commentaire dans le coin des cellules peuvent étre difficiles a distinguer.
Par conséquent, Calc propose une autre fagon de les repérer, en utilisant le Navigateur. S'il existe
des commentaires dans un classeur, le Navigateur affiche une marque (habituellement le signe +
ou une fléeche) devant le mot Commentaires. Cliquez sur cette marque pour afficher la liste des
commentaires. Double-cliquez sur le commentaire voulu pour aller directement dans la cellule
associée.

Ajouter d'autres commentaires 11



Réviser les modifications

A ce point de I'explication, vous allez inverser les roles et devenir I'entraineur de I'équipe, pour que
VOus puissiez voir comment réviser et accepter ou refuser les modifications apportées au
document.

Vous étes désormais I'entraineur d'une équipe de football de jeunes et vous avez soumis une
proposition de budget annuel au président de votre club. Ce dernier a révisé le document en
utilisant les fonctionnalités d'enregistrement des modifications dans Calc. Vous voulez maintenant
réviser ces modifications et accepter ou refuser ces contre-propositions. Etant donné que votre
président a enregistré ses modifications dans Calc, vous allez pouvoir facilement voir quels
changements ont été effectués et décider comment agir.

Afficher les modifications

Calc vous donne un contrble complet sur les modifications que vous affichez lorsque vous révisez
un document. Pour modifier les filtres en cours, sélectionnez Edition > Modifications > Afficher.
La boite de dialogue de la Figure 9 s'ouvre.

Afficher les modifications @

| iAfficher les modifications dans la feuille de calcul;

Paramétres de filtre | Annuler |
Dat avant le 31/12/1985 .
- | | Aide |
Auteur |C ris |
Plage

Commentaire

Afficher les modifications acceptées

Afficher les modifications rejetées

Figure 9 : Boite de dialogue Afficher les modifications

Au moyen des différents paramétrages, vous pouvez contrbler quelles modifications vont s'afficher
a I'écran. Vous pouvez les filtrer selon :

* La date : seules les modifications effectuées au cours d'une certaine période seront
affichées.

* |'auteur : seules les modifications effectuées par un auteur particulier seront affichées.
Ceci est particulierement utile si vous avez plusieurs relecteurs pour votre document.

* Laplage : seules les modifications effectuées dans une plage de cellules particuliére seront
affichées. Ceci est particulierement utile si votre classeur est grand et vous voulez ne
réviser qu'une partie du document.

* Le commentaire : seules les modifications dont le contenu du commentaire correspond au
critére de recherche spécifié seront affichées.

* Les modifications acceptées : seules les modifications acceptées seront affichées.
* Les modifications rejetées : seules les modifications rejetées seront affichées.
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Vous pouvez également accéder au contrble des filtres a partir de la boite de
Note dialogue Accepter ou rejeter les modifications de la Figure 10. Cliquez sur l'onglet
Filtrer pour disposer d'un ensemble d'options similaires a celles de la Figure 9.

Accepter ou rejeter les modifications

Lorsqu'un document vous est retourné avec des modifications, tout l'intérét de I'enregistrement des
modifications devient évident. Vous pouvez alors, en tant qu'auteur initial du document, parcourir
les modifications effectuées et décider de leur sort. Pour commencer ce processus :

1) Ouvrez le document modifié.

2) Sélectionnez Edition > Modifications > Accepter ou rejeter. La boite de dialogue de la
Figure 10 s'ouvre.

3) Calc parcourt individuellement chaque modification. Vous pouvez accepter ou rejeter
chaque modification au fur et a mesure.

Accepter ou rejeter les modifications [E3m]
Liste |Filtrer
Action Commentaire
Feuillel B3 17/06/2012 15:47:. On ne remp
Contenu modifié  Feuillel.C4 Chris 17/06/2012 15:51:4  (Cellule T4 modifié
Contenu modifié  Feuwillel .B7 Chris 17/06/2012 15:51:  (Cellule BY modifié
Contenu modifié  Feuillel B3 Chris 17/06/2012 15:51:  (Cellule B9 madifié
1] 1 3
[ ] ’ Befuser ] ’ Tout accepter l [ Tout refuser

Figure 10 : Boite de dialogue Accepter ou rejeter les modifications

La colonne Commentaire contient I'explication par défaut de la modification effectuée. Sile
relecteur a ajouté un commentaire a sa modification, il est affiché avant I'explication par défaut,
comme sur la premiére ligne de la Figure 10.

Si plus d'un utilisateur a révisé le document, un relecteur a pu rectifier une modification d'un autre
relecteur. Dans ce cas, les modifications sont structurées logiquement avec un signe + qui permet
d'ouvrir I'arborescence.

L'onglet Filtrer vous permet de filtrer les modifications affichées par date, par auteur, par plage ou
par contenu du commentaire. Apres avoir spécifié les critéres de filtre, revenez a I'onglet Liste pour
voir le résultat.
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Fusionner les documents

Envisageons le cas de figure ou vous avez envoyé votre proposition de budget non seulement au
président de votre club, mais aussi a votre entraineur adjoint. Tous les deux vous renvoient leur
budget révisé en méme temps. Vous pourriez réviser chaque document séparément, mais, pour
gagner du temps et étre plus efficace, vous pouvez vouloir analyser I'ensemble de leurs
modifications simultanément. Pour ceci, vous pouvez utiliser la fonction de fusion de document de
Calc.

Les méthodes décrites jusqu'ici sont efficaces si vous n'avez qu'un relecteur a la fois. Parfois
cependant, plusieurs relecteurs renvoient toutes les versions modifiées d'un document en méme
temps. Dans ce cas, il est plus rapide et efficace de réviser toutes ces modifications en une seule
fois, plutét que de le faire individuellement pour chaque version. Pour ceci, vous pouvez fusionner
les documents dans Calc.

Pour fusionner des documents, la fonction d'enregistrement des modifications doit étre active pour
chacun d'entre eux.

1) Ouvrez le document d'origine.

2) Sélectionnez Edition > Modifications > Fusionner le document.

3) Une boite de dialogue de sélection de fichiers s'ouvre. Sélectionnez le fichier que vous
voulez fusionner et cliqguez sur OK.

4) Une fois la fusion des documents effectuée, la boite de dialogue Accepter ou rejeter les
modifications s'ouvre, comme dans la Figure 11, et affiche les modifications de plusieurs
relecteurs. Si vous voulez fusionner plus de documents, fermez la boite de dialogue et
répétez les étapes 2 et 3.

i =

Accepter ou rejeter les modifications @
Liste |Filtrer |
Action Commentaire
Feuwllel .B3 17/06/2012 15:47:. On ne remp
Contenu modifié  Feuillel.C4 Chris 17/06/2012 15:51:«  (Cellule C4 maodifié
Contenu modifié  Feuillel .B7 Chris 17/06/2012 15:51:  (Cellule BY modifié
Contenu modifié  Feuillel B9 Chris 17/06/2012 15:51:  (Cellule B9 modifié
Contenu modifié  Feuillel,B4 Jean 19/06/2012 17:37:0 5 supplémentaires g
Contenu modifié  Feuillel .C8 lean 19/06/2012 17:38::  (Cellule C& modifié
4 1 P
[ gcr_epter ] ’ Befuser l ’ Tout accepter ] ’ Tout refuser

Figure 11 : Accepter ou rejeter les modifications de documents fusionnés

Les modifications sont alors combinées dans un seul document et vous pouvez les accepter ou les
rejeter au cours d'un méme processus. Les modifications de chaque relecteur apparaissent avec
des couleurs différentes dans le document, comme illustré Figure 12. Dans cet exemple, les
modifications de Chris sont en rouge et celles de Jean en bleu.
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e b | c | D | E
1 Budget Equipe Cadets Football
2 |Description Quantité Prix Total Commentaire
3 |Maillots, shorts et chaussettes = 40,00 € 200,00 € Besoin d'un nouveau look pour l'équipe
4 |Ballons entrainement 25 15,00 €] 375,00 €1 par joueur + 5 en réserve
5 [Ballons match 3 40,00 € 120,00 € Pour la saison
6 |Colts arbitrage 18 50,00 € 900,00 €1 arbitre par match
7 |Collations 0 40,00 € 0,00 €1 collation d'aprés-match par match
& |Gants gardien 1 25,00 € 25,00 € Pour le gardien
9 |Protége-tibias de rechange 2 15,00 € 30,00 € Dans le cas od un joueur oublie ses protections
10 |Chasubles entrainement 20 400€ 80,00 €1 par joueur + 5 en réserve |
11 |(Total 1730.00 €
12

Figure 12 : Documents fusionnés et relecteurs avec des couleurs différentes

Comparer des documents

Parfois, quand vous partagez des documents, les relecteurs peuvent oublier d'enregistrer leurs
modifications. Ce probléme peut étre résolu par Calc, qui peut retrouver ces modifications en
comparant des documents.

Pour comparer des documents, vous devez disposer du document original et de celui qui a été
modifié. Pour les comparer :

1) Ouvrez le document modifié que vous voulez comparer au document original.

2) Sélectionner Edition > Comparer le document.

3) Une boite de dialogue de sélection de fichier s'ouvre. Sélectionnez le document original et
cliquez sur Insérer.

Attention
é Veillez a bien ouvrir le document modifié en premier et non le document original.

Calc détecte et repére les modifications de la fagon suivante :

* Toutes les données qui se trouvent dans le document modifié mais pas dans le document
original sont repérées comme insérées.

* Toutes les données qui se trouvent dans le document original mais pas dans le document
modifié sont repérées comme supprimées.

* Toutes les données modifiées sont repérées comme modifiées.

A partir de ce point, vous pouvez parcourir ces repéres et accepter ou rejeter les modifications.

Enregistrer des versions

La plupart des documents passent par plusieurs versions. Il est souvent utile d'enregistrer les
nouvelles versions d'un document. Vous pouvez le faire en enregistrant une copie du document
(sous un nom différent) aprés chaque révision, ou en utilisant la fonctionnalité de gestion des
versions de Calc.
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Attention . . . , . . .
- Si vous faites un Enregistrer sous d'un document qui comporte plusieurs versions,

ces anciennes versions ne sont pas enregistrées dans le nouveau fichier.

Pour utiliser la gestion des versions de Calc :

1) Choisissez Fichier > Versions. La boite de dialogue Versions s'ouvre.

Versions de Bx_maodifsl

Mouvelles versions
Fermer

[ Enregistrer une nouvelle version l [7] Toujours enregistrer une version lors de la fermeture

. . Chuvrir
Versions existantes

Date et heure Enregistrée par Commentaires Afficher...

20/06/2012,11:32:03  Chris

Supprimer

Cormparer

Ll

Figure 13 : Boite de dialogue de gestion des versions

2) Cliquez sur le bouton Enregistrer une nouvelle version pour enregistrer une nouvelle
version.

3) Une boite de dialogue s'ouvre, ol vous pouvez saisir un commentaire sur cette version.

Insérer un commentaire de version (facultatif) @

Date et heure : 00,/00,0000, 00:00.00

Enregistré par Chris

ersion acceptée par le président

oK || Annder | | Aide

Figure 14 : Boite de dialogue de commentaire de version

4) Aprés avoir saisi votre commentaire et cliqué sur OK, la nouvelle version est ajoutée dans
la liste.
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Verzions de Bx_modifsl

Mouvelles versions
Ferrmer

[ Enregistrer une nouvelle version l [7] Toujours enregistrer une version lors de la fermeture

) ) Chavrir
Versions existantes
Date et heure Enregistrée par Commentaires Afficher...
20/06/2012,11:32:03  Chris Original SuDDrmer
20/06,2012,11:39:30  Chris Wersion acceptée par le président 24UPP

Cormparer

iteL |

Aide

Figure 15 : Liste des versions mise a jour

Une fois que vous avez enregistré le fichier, les deux versions y sont présentes. Vous pouvez
alors :

e Quvrir une ancienne version : sélectionnez la version et cliquez sur le bouton Ouvrir ; une
copie en lecture seule de I'ancienne version s'ouvre.

Comparer toutes les versions : cliguez sur le bouton Comparer et une action similaire a la
fusion de documents s'effectue. Une boite de dialogue Accepter ou rejeter les modifications
s'ouvre et liste toutes les modifications a travers les différentes versions.

Modifier le commentaire : sélectionnez une version et cliquez sur le bouton Afficher pour
afficher le commentaire saisi par vous ou d'autres relecteurs.

Le nouveau fichier a une taille supérieure, comme si deux classeurs étaient

Note enregistrés ensemble.
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